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Introduction 
 
Understanding the geographical distribution of your customers and prospects 
can increase insight of your marketplace, highlight areas of untapped 
potential and facilitate campaign planning and execution.  The Market Insight 
Geo module is an integration with Microsoft Bing Maps that allows you to 
visualize the spatial distribution of your data and export targeted selections 
for immediate use in your marketing campaigns. See Appendix 1 – Further 
Information. 
 
Microsoft Bing Maps 
 
Online mapping using Bing & OpenStreetMap provides street level mapping 
for all regions in the world.  Users will need to subscribe to the online Bing 
Maps web service with a Bing Key. This can be arranged by contacting your 
Market Insight consultant.  OpenStreetMap is a free service.   
 
 

 N.B. This document looks at the main relationship between Market Insight 
and the Mapping tools.  For specific functionality of the mapping software 
refer to the Microsoft online help. 
 

 N.B. The examples in this document are for illustrative purposes only.  You 
will not be able to follow these exact examples in reality unless you have the 
relevant licensed software and access to the Market Insight training system. 

  

 
            Microsoft Bing Maps 
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Data Structure 
 
The structure of your Market Insight system can vary.  The elements shown 
here are typical – each Record may be simply flagged with Customer data or 
can have many related Names.  A Record may also have many matched 
Customer Accounts. The data loaded for each matched Customer Account is 
configurable – for example you may have multiple Transactions or Divisional 
Summaries or Product Summaries etc. 
  
The detail present on each table of data depends on the Market Insight 
administrator.  The data is arranged into folders to assist the user to navigate 
and find data items. 
 
 
The structure used in the Training System, illustrated in this manual, uses a 
simple structure that has Records (organisations) with Names (contacts at the 
organisation).  Also a subset of the Records called Customers (the Users 
customers) is held with a related table Policies (activity of the Users 
customers). 
 
 
 
 

 
 
 

Rec  
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How to Login  
 
To use Market Insight, you need to have an Internet connection.   
 
Start Market Insight by: 

 Clicking on the Market Insight icon on your desktop, or by 
navigating to the program using Window Explorer 

 
 
In the upper left hand corner of the screen you will see a Login window that 
gives you the opportunity to connect to a Market Insight system containing 
data available to you for analysis. 
 
 

Enterprise Tab 
 
Your Market Insight system operates on a secure and resilient web connected 
server enabling you to access the system from any location with an Internet 
connection.  A number of users may access the system at the same time, each 
of whom is authorized by a user account and password.  Your Market Insight 
Administrator will provide you with a Username and Password. 
 

 Enter your details if appropriate and click the Login button 
 

 
 
 
 
 
 
 
 
 

  
 

 
                                            Login Window              
                                                                 
                                 
 
 
 
 
 
 
 

 



D&B Market Insight – Geo Mapping     User Guide 
 

D&B Ltd © 2009 - 2018  4 

Map Options 
 
You can select your Bing license and the default settings you see, from the 
Market Insight Options window. 
 

 On the menu bar click on File → Tools → Options… 
 

 Under the Sections column select Map to see 3 further sub menus 
 
The screen shot opposite shows the Map region options set to World for 
use with Bing.  Other default settings such as map type, distance units, 
routing options can be made on the other sub menus. 
 
 
 
 
 
 
 
 
To start using your mapping tool: 
 

 Open a selection window containing the records you wish to work 
with 

 
 Drag the Map tool from the Visualization section of the Toolbox 

ribbon bar onto your selection window 
 
 
 
 
 
 

  

 
                 Market Insight Discoverer – Options Window 

 
 

 
                                                                Toolbox Ribbon Bar – Map Option 
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Bing Maps 
 

Shaded Map 
 
A shaded map allows us to display records using particular geographical 
boundaries e.g. by Postcode Area, Postcode District or Postcode Sector in the 
UK  This gives us the opportunity to look at the distribution of our contacts or 
prospects around the country. 
 
In the following example we will display a selection of Records which are High 
Sales Manufacturing Industries. 
 

 Create a selection query that identifies Records with a Major Industry 
Sector of Manufacturing and Banded Sales of >£10,000,000 

 

 Drag and drop the  Map tool on top of the selection window 
 
The Map page has two tabs; the one entitled Map currently shows the default 
display region and will be where the final display will be shown.  The second 
tab, entitled Layer 1 is where we define how the results will be displayed.  
Multiple layers can be added to your map, which will be covered further on in 
this document. 
 

 Click on the Layer 1 tab 
 
An explanation of the options on this window is shown on the next page. For 
now we will just make the changes shown in the screen shot opposite i.e. drag 
on UK Postcode Area as the Geographical Variable and change the layer title. 
 

 Click the Build button 
 
 

  

 
                           The Map Tool – Bing Map Tab 
 

 
                           Layer Tab – Shaded Map 
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Shaded Map - The Layer Tab 
 

 
Map Layer Title 
 

 
Enter the description to be shown on the layer tab and legend display 

 
Resolve Table & Filter 
 

 
Set the table level and any record filter here to determine the records shown e.g. Customers or Policies figures 

 
Map Type 
 

 
Choose between the Shaded and Plot Map options 

 
Default Display Style 
 

 
When viewing the Map results select to show the Descriptions or Codes for items 

 
Geographic Variable 
 

 
Drag and drop here the geographical variable to determine how the data will be shown on the Map 

 
Segment Variable 
 

 
Allows you to segment the data by the selection variable used, displayed as pie, column charts etc. 

 
Statistics Panel 
 

 
This area displays all the statistics that have been added for possible display on the map 

 
Add Statistics… 
 

 
The statistics window allows you to define which statistics will be made available in the statistics panel 

 
Help… 
 

 
Click this link to open the Market Insight Help files 

 
Display MapPoint Wizard for Next Build 
 

 
Displays the wizard each time the map is built so you can change the graph type and other options 
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Shaded Map – Viewing the Map 
 
Now that the results have been calculated and displayed, we can see each 
State that contains records from our selection has been colour shaded.  The 
colour shading has defaulted to 8 Equal Data Points.  Options for this layer can 
be set in the Layers panel. 
 
 

Visibility: 
 
Type: 

Make the layer display visible or hidden on the map 
 
Displays the appropriate type of map from those listed 
 

Scheme: Select a colour scheme to be applied to the shading and the 
type and number of ranges to use 
 

Opacity: 
 
 
 
 
 
Show 
Labels: 
 
Border: 
 

This allows control over how visible the layer is over the map.  
Moving the slider to the right makes the layer colours more 
solid until the map is no longer visible.  Moving the slider to the 
left makes the layer colours more translucent until only the 
underlying map is visible 
 
Marking the check box will turn on the layer labels rather than 
just show them when the mouse pointer hovers over an item 
 
This determines the colour used to define, in this example the 
Postcode Area borders.  By clicking on the drop down arrow 
different colour options can be chosen from the palette 
 

 
 
 
 
 
 
 

  
 
 
 

 
                                                             Bing Map – Layers Panel 
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Zoom & Drag 
 
At the top left of the window is a group of 3 map actions.  The highlighted item 
is the active function. 
 

None 
 

This keeps the map static when the mouse is moved over it 

Zoom 
 

A left drag will select an area and zoom into it 

Drag 
 

A left drag will move the map in the direction of the mouse 

 
 
At the bottom right of the map window is a pop out control. 
 

 Move the mouse pointer over the bottom right of the window to bring 
the zoom and drag function to the foreground 

 
The zoom and drag function options are shown below: 
 

 
Clicking on this symbol zooms out of the map  
 

 
Clicking on this symbol zooms into the map  
 

 
Clicking on this symbol will reset the zoom to its widest view 
 

 
Clicking on this symbol will select the default mouse action 
 

  
  

 
 
 
 
 

 

 
                                         Bing Maps – Zoom & Drag Options 

 
 
 

 
                                                   Bing Maps – Zoom Options 
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Further display options can be found in the top right of the window: 
 

 
 

Provider 
 

 

  No Map 
 

No mapping functionality is displayed 

  Open Street Map 
 

This free mapping service is displayed 

  Bing Map 
 

This licensed mapping service is displayed 

Imagery 
 

 

  Road 
 

The road network is overlaid onto the Region 
selected 
 

  Hybrid 
 

The road network is overlaid onto a photographic 
aerial view of the Region selected 
 

  Aerial 
 

A photographic aerial view is overlaid onto the 
Region selected 
 

Region 
 

Select the geographical country of focus 

 

 N.B. To see the Imagery options more clearly on the map the Opacity level 
may need to be reduced. 
 
 
 
 

 
                                      Bing Map – Hybrid View 

 
 
 
 

  
                                      Bing Map – Aerial View 
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Shaded Map – Viewing the Results 
 
The map opposite uses Postcode Sector. 
 
The results of our underlying selection have been applied through the colour 
shading.  The legend, depending on the settings used may have a wide range 
of results associated with a particular colour. 
 
To find the actual result move the mouse pointer over the Postcode Sector of 
interest, which will be highlighted and the tooltip will display the count. 
 
To select results from our map we can use tools from the Drawing Tool bar at 
the top of the window.  In this example we will use the scribble tool to find an 
area of interest. 
 

 Click on the Scribble tool and then click and hold the left mouse 
button to draw a joined up shape 

 
 An item will be entered under the Selections section of the Layers 

panel. Click and drag the  button onto the workspace to see and 
count the selection 

 

 N.B. – The line drawn on the map crosses several Postcode Sectors, so 
how does Market Insight interpret your shape?  Market Insight looks to see if 
your line crosses the border of a geographical variable and if it does it will 
include everyone in that area.  So for a more accurate results use more 
granular variables. 
 

 N.B. – See pg. 20 for more details on the various selection tools. 

 

 
                            Shaded Map – Tooltip Count Display 

 

 
                            Shaded Map – Scribble Tool Selection 
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Shaded Map – Using a Segment Variable 
 
When using the shaded map option it is possible to display segmented data 
from a selector variable or selection query.  For example we may wish to 
display graphically the Policy Product Type our Records have purchased by the 
Postcode Area in which they are based. 
 

 Using a blank selection drag on a Map tool and change the Layer 1 tab 
to reflect the options in the screen shot opposite 

 

 Click the Build button 
 
The default display uses a sized pie chart to show the categories of the 
variable.  The legend indicates the colour coding used to identify each of the 
segments. 
 
The chart used can be changed by going to the Layers panel on the left of the 
screen, and making a selection from the Type drop down menu. 
 

 N.B. Moving the mouse pointer over a chart on the map will display the 
count for each category of the variable used.  If a specific segment of the pie 
chart is touched by the mouse pointer the name and percentage of that 
segment will be displayed.  
 
 

  

 
                                          Layer Tab – Occupation as the Optional Segment Variable 

 
 

 
                                        Bing Map – Display of a Segment Variable Results 
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Shaded Map – Adding Statistics 
 
As well as displaying values e.g. the number of Customers on a map, you can 
also generate and display a calculated statistic for those people being 
represented on the map. 
 
Let’s use the example the previous example.  We can now amend this example 
to optionally display the total profit from each of these Policy Product Types 
per Postcode Area. 
 

 Click on the Layer tab  
 

 Click on the Add Statistics… button to display the Statistics window 
 

 Click on the radio button Specify other Table, Variable or Expression 
 

 We can now drag on the Policy Premium variable and select the 
statistic we want to apply (in this example Sum) 

 
 Click OK 

 
 Within the Statistics panel change the Primary Statistic Sum(Policy 

Premium) 
 

 Click the Build button 
 
When we move the mouse pointer over a chart, the tool tip that is displayed 
now shows the Sum cost Per Policy type in each Postcode Area. 
 
 
 
 
 

 

 
                                     Statistics Window – Summing the Profit Value for People 
 

 
                                       Sum of Division 1 Spend 
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Plot Map 
 
A plot map allows us to display records using a more precise geographical 
boundary e.g. by UK Postcode.  This gives us the opportunity to look at the 
location of smaller groups of customers or prospects around the country. 
 
In the following example we will display a selection of Records with High Sales 
Volume from the Coventry Postcode Area. 
 

 Create a selection query that identifies Records with High Banded 
Sales (>£10,000,000) in the Coventry UK Postcode Area (CV) 

 

 Drag and drop the  Map tool on top of the selection window 
 

 Click on the Layer 1 tab 
 

 Change the Title to High Sales Volume Coventry 
 

 Complete the window as shown opposite 
 

 Click the Build button 
 
 
An explanation of the options on this window are shown on the next page. 
 
 
 
 
 

  
 
 

 
             Layer Tab – Plot Map 
 
 
 

 
 

 
           Additional Variables – Display Style 

 
  



D&B Market Insight – Geo Mapping     User Guide 
 

D&B Ltd © 2009 - 2018  14 

Plot Map - The Layer Tab 
 

 
Map Layer Title 
 

 
Enter the description to be shown on the layer tab and legend display 

 
Resolve Table & Filter 
 

 
Set the table level and any record filter here to determine the records shown e.g. People or Household figures 

 
Map Type 
 

 
Choose between the Shaded and Plot Map options 

 
Default Display Style 
 

 
When viewing the Map results select to show the Descriptions or Codes for items 

 
Geographic Variable 
 

 
Drag and drop here the geographical variable to determine how the data will be shown on the Map; in this case use 
latitude and longitude as discussed on the previous page. 
 

 
Add Reference Number 
 

 
This allows a selection to be dragged off the map listing the DUNS 

 
Additional Variables 
 

 
Information for these variables can be accessed for records displayed on the map 

 
Display MapPoint Wizard for Next Build 
 

 
Displays the wizard each time the map is built so you can change the graph type and other options 
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Plot Map – Viewing the Map 
 
To get a closer or different view of the Map use the functions described on 
pgs. 8 & 9. 
 
The screen shot opposite shows the map centred over Coventry.  
 
The Layer options are as follows: 
 
 

Visibility 
 

Make the layer display visible or hidden on the map 
 

Type 
 

Select the type of pushpin to display 

Scheme 
 

Select a colour scheme to be applied to the shading and the 
type and number of ranges to use 
 

Symbol 
 

Select the type of symbol to represent the pushpin 

Size 
 

This control allows the pushpins to be increased or decreased 
in size 
 

Opacity 
 

This allows control over how visible the layer is over the map.  
Moving the slider to the right makes the layer colours more 
solid until the map is no longer visible.  Moving the slider to 
the left makes the layer colours more translucent until only 
the underlying map is visible 
 

Colour by 
 

This will colour code the pushpins by an additional variable 
selected from the list  

 
 
 
 

  

 
           Plot Map – High Sales in Coventry Postcode Area 
 
 

 
                                                                            Plot Map – Colour by 
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Plot Map – Viewing the Results 
 
To select results from our map we can use tools from the Drawing Tool bar at 
the top of the window.  In this example we will use the scribble tool to find an 
area of interest. 
 

 Click on the Scribble tool and then click and hold the left mouse 
button to draw a joined up shape 

 
 An item will be entered under the Selections section of the Layers 

panel. Click and drag the  button onto the workspace to see and 
count the selection 

 
The selection we have just made on the map can be renamed for easier 
reference.   
 

 Rename the selection from Scribble 1 to Warwick Selection 
 
To remove the selection permanently from the map click on the Delete button 
on the relevant selection row, under the selections heading. 
 
 

 
 
 

 N.B.  See pg. 20 for more details on the various selection tools. 
 
 
 
 
 

 
 
 

 
                                        Plot Map – Scribble Tool Selection 
 
 

 
              Selection 
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When setting the options on the Layer tab variables were added to the 
Additional Variables panel.  This will allow the information for the records to 
be displayed on the map. 
 

 Move the mouse pointer over a pushpin to see information for that 
record 

 
If the pin represents a single record, a balloon will appear with the DUNS and 
the relevant variable information for that record. 
 
If the pin represents more than one record, a window will appear listing the 
postcode for each of those records. 
 

 
                         Plot Map – Show Information 
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Plot Map – Create DriveTime Zone 
 
It is possible to use this function to find Sites who live within a determined 
area calculated upon the number of minutes or the distance it takes to drive 
from a given point. 
 
Using the Plot Map from the last example, create a drive time zone of 20 
minutes from Birmingham Airport. 
 

 Right click on the map and select Search… , from the pop up menu, 
for your centre point 

 
 Type Birmingham Airport into the Location box and click OK 

 
If necessary we can be more specific with our starting point by using a 
Postcode. 
 

 Right click on the location 
 

 Select DriveTime… 
 

 Set the DriveTime to 20 minutes and click OK 
 
You can now find out how many Records on the Market Insight system are 
within this 20 minute drive time by: 
 

 An item will be entered under the Selections section of the Layers 

panel. Click and drag the  button onto the workspace to see and 
count the selection 

 
The result will be all the records, in the underlying selection, shown on the 
map which can be reached within a 20 minute drive from Birmingham Airport. 
 

  
 

 
                                      DriveTime Settings Window 
 

 
                                        DriveTime Zone Display 
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Multiple Layered Maps 
 
It is possible to create Maps with multiple layers.  These layers can be either 
shaded or plot maps using different selections.  To show the two maps created 
earlier on the same map page: 
 

 Redisplay the shaded Map of Records which are High Sales 
Manufacturing Industries. 

 

 Click the  button to apply a second set of settings to your 
Map 

 
To investigate where Live Policies are held:  
 

 Create a Customer Level Selection of Policy Status - Live 
 

 Drag the selection onto the Return all People filter box of Layer 2 
 

 Use the settings shown in the screenshot. 
 
This has to be applied in this way because the underlying selection window 
still holds the High Sales Manufacturing Industries query used on the shaded 
map. 
 

 Apply all the other settings as previously 
 

 Click on the  Build button to see the results  
 
The result is a display that now shows a shaded map of Records with High 
Sales in Manufacturing, with pushpins indicating where Customers with Live 
Policies are located.   
 

 N.B.  To select from a particular layer, ensure all other layers are set to 
Hidden. See pg. 20 for more details on the various selection tools. 

  

 
                     Settings to Show Layered Map 

 
                      Layered Map Display 
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Selecting from the Map 
 

 
Adhoc 
 

 
Select or deselect by clicking on individual regions on the map e.g. records displayed by Postcode 

 
Scribble 
 

 
Select an area of the map by clicking, holding and dragging the pointer over the desired area 

 
Polygon 
 

 
Click on the map and every subsequent click will join the previous point to the new point, until you have identified the area 

 
Rectangle 
 

 
A click and drag will draw a rectangle in any direction from the point where you clicked 

 
Oval 
 

 
A click and drag will draw an oval in any direction from the point where you clicked 

 
Radius 
 

 
A click and drag will draw a circle radiating from your click point, the tooltip indicates the radius distance 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                     Adhoc Selection                                                                                               Scribble Selection                                                                                        Radius Selection 
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Map Wizards 
 
This group of wizards interacts with Bing Maps or Microsoft MapPoint to allow 
you to identify records in relationship to time and distance, using geographical 
variables.  The result of these wizards will create a Virtual Variable, which will 
appear in the System Explorer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 
 

 

 
 
    Wizards Ribbon Bar – Map Wizards Section 
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Drive Zone Wizard 
 
The Drive Zone wizard provides a quick way to group records by their distance 
(or drive time) from a specific point.  When grouping records by distance, the 
distance “as the crow flies” is used. 
 
 
 
Example 
 
Create a Selector virtual variable of 30 minute Drive Zones based from the 
central point of East Midlands Airport to see where existing Records are 
located in terms of drive time from the airport. 
 

 Click the  Drive Zone wizard icon 
 

 Settings – Set the World Region to World and the unit to measure 
distance.  Click Next 

 
 Centre Point – Enter the centre point, this could be a postcode or 

town name.  If you have multiple centre points it is possible to drag a 
file containing them onto the drop zone box at this stage.  In this 
example use East Midlands Airport Postcode DE74 2SA.  Click Next 

 
 Select Geographic Match Variable – Drag on the geographical 

variable that will be used to plot the points from the centre point UK 
Postcode District.  Click Next 

 
 Time or Distance – Determine if you are going to create a variable 

based upon drive time or distance – Use Distance as the Crow Flies  
 
 
 
 

 

 
                                      Drive Zone Wizard - Settings 

 
                                       Drive Zone Wizard - Select Geographical Match Variable 
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 Zones – Determine the zones to be created.  Enter the information as 

shown opposite to calculate half hourly zones from the centre point.  
Click Next 

 
 Notes – Add Optional Notes.  Click Next 

 
 Update Variable – Type the description name for the variable – 

[centrepoint] East Midlands Airport.  Click Next 
 

 Security – This step is only visible if you are running an Enterprise 
system and you have ticked the Modify Security Attributes box in the 
previous step. Click Next 

 
 Finish – This step will tell you how many records have been updated.  

Click Finish 
 
 
The virtual variable is now available for you to select individual or consecutive 
30 minute drive zones from East Midlands Airport. 
 
The Unclassified category in this example will be all Records with Postcode 
Districts over 120 minutes from East Midlands Airport. 
 
 
Suggested Uses 
 

 Identify customers/prospects within a certain distance from a retail 
outlet 

 
 
 

 

 
                                           Drive Zone Wizard - Zones 

 

 
                                    Selection Window – East Midlands Airport Drive Zones Virtual Variable 
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Location Geocoder Wizard 
 
The Location Geocoder wizard gives us the opportunity to create Latitude and 
Longitude Virtual Variables.  For a given group it will calculate the Latitude and 
Longitude for each distinct value for a geographical variable within the 
selection. 
 
 
 
 
Example 
 
Create the Latitude and Longitude variables to allow you to find the Records, 
by Postcode exhibiting particular characteristics 
 

 Click the  Location Geocoder wizard icon 
 

 Selection – Drag on a selection at the Records with Banded Sales of 
£1,000,000,000+.  Click Next 

 
 Geographical Match – Set the World Region to World and drag on a 

geographic variable (UK Postcode Area) which can be a place or part 
of a postcode that can be evaluated to a single point  

 
 Tick the box Geographical variable is either part or whole of a 

Postcode/postcode.  Click Next 
 

 Folders – Select or create a folder where you want to place your 
Virtual Variable.  Leave the default for the Others folder.  Click Next 

 
 Notes – Enter optional notes.  Click Next 

 
 

 

 

 
                                     Location Geocoder Wizard - Selection 
 

 
                                       Location Geocoder Wizard - Geographic Match 
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 Latitude Name - Type the description name for the Latitude variable 

– High Sales - Latitude.  Click Next 
 

 Longitude Name - Type the description name for the Longitude 
variable – High Sales - Longitude.  Click Next 

 
 Finish - This step will tell you how many records have been updated.  

Click Finish 
 
 

 N.B. Security - This step is only visible if you are running an Enterprise 
system and you have ticked the Modify Security Attributes box on the 
Latitude Name or Longitude Name steps.  It allows you to select security 
options for yourself, groups you belong to or anyone else. 
 
 
Suggested Uses 
 

 Identify locations using latitude and longitude information 

 

 
                                           Location Geocoder Wizard – Latitude Name 
  

 
                                           Location Geocoder Wizard – Longitude Name 
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Point to Point Wizard 
 
The Point to Point Wizard provides a way to record the drive time or distance 
between a selection of records and a specified centre point as a virtual 
variable. 
 
Example 
 
Create a Numeric virtual variable to find the number of customers with Policy 
Product A, by distance from Warwick to various Postcodes. 
 

 Click the  Point to Point wizard icon 
 

 Selection – Drag on a Selection to find Customers with a Policy 
Product of A from the West Midlands.  Click Next 

 
 Settings – Set the World Region to World and the preferred unit and 

route options.  Click Next 
 

 Centre Point – Enter your centre point (Warwick) which can be a place 
or part of a postcode that can be evaluated to a single point.  You also 
have the opportunity to drag on a file if you have multiple centre 
points.  Click Next 

 
 You may find at this point a pop up window appears to confirm the 

entry you made.  Select the correct location 
 

 Select Geographic Match – Drag on the geographical variable 
(Postcode) so that a calculation can be made between the centre 
point (Warwick) and the centre points of each geographical area as 
limited by the selection 

 
Tick the box Geographical variable is either part or whole of a 
Postcode/postcode.  Click Next 

 

 

 
                                           Point to Point Wizard - Centre Point 
 

 
                                           Point to Point Wizard - Select Geographic Match 
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 Type – This step allows you to decide if the variable created will be 
based upon drive time or distance.  Select the Use Drive Time radio 
button. 

 
 Folders - Select or create a folder where you want to place your Virtual 

Variable.  Leave the default for the Others folder.  Click Next 
 

 Notes - Enter optional notes.  Click Next 
 

 Update Variable - Type the description name for the variable – 
Warwick Point to Point.  Click Next 

 
 Security - This step is only visible if you are running an Enterprise 

system and you have ticked the Modify Security Attributes box in the 
previous step 

 
 Finish - This step will tell you how many records have been updated.  

Tick the Show new variable as a selection box.  Click Finish 
 
You can now make distance selections in the numeric variable by typing in the 
free form box.  E.g.  2-100 will return customers within a Postcode, between 
20 and 100 miles from the central point of Warwick. 
 
 
Suggested Uses 
 

 Identify distance/time between retail outlet and customers 
 

 Calculate average time travelled by customer segments – drop the 
variable onto a cube and use the average function to see breakdown 
of customer groups 

 

 
                                          Point to Point Wizard - Type 

 
                                          Point to Point Wizard - Update Variable 
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Appendix 1 – Further Information 
 

Market Insight Geo Module 
 
This license comes with the OpenStreetMap free service.    To use Microsoft 
Bing Maps, the online mapping service, you will need a Bing key, which can be 
obtained through Apteco. To use Market Insight with Microsoft MapPoint you 
will need to have a licensed copy of this software and have it installed on the 
machine with which you are accessing your Market Insight system. 
 

 
 
Boundary Files 
 
To apply data to your online maps you will require boundary files, also known 
as shape files.  Apteco can provide basic UK shapes; Postal Area, Postal District 
and Postal Sector. 
 
Various boundary files are available and some nations e.g. Australia make 
these available free of charge. 
 
A broader range of boundary files, can be purchased from commercial 
organizations such as MapMechanics – www.allmapdata.com 
 
Other commercial providers are available. 
 

  
 

Bing Maps 
 
A Bing key gives you access to the geocoding functionality of the software and gives 
you a potential worldwide display, with the appropriate boundaries.  Bing maps 
gives you access to the majority of MapPoint functions except for the Mapping 
Wizards. 
 
www.bing.com 

 
 
OpenStreetMap 
 
As OpenStreetMap is a free service and without the addition of Bing Maps, will only 
allow you to display thematically shaded maps, with the appropriate boundary files 
being available.  With a Bing Maps key, OpenStreetMap can display the geocoding 
functions on its map display. 
 
www.openstreetmap.org 
 

 


